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1 Introduction

Ce manuel explique l'installation, la configuration et l'utilisation du module de paiement pour
OpencCart et Datatrans.

Avant de commencer l'installation, s'il vous plait assurer-vous que vous étes en possession de
toutes les données nécessaires:

® \ous devriez avoir recu un Merchant ID par Datatrans pour le compte test (commencant
par IXXXXXxxx) ainsi qu'un Merchant ID pour le compte live (commengant par 3XXXXXxxx). En
outre, vous avez recu le username et mot de passe correspondant

® OpenCart module de paiement par sellxed.com/shop

® Données d'accés a votre serveur et boutique

Au cas ol vous ne disposez pas encore d'un contrat avecDatatrans,vous pouvez |' acquérir
directement a travers nous.

Veuillez noter que nos plugins nécessitent l'utilisation de PHP version 5.6 au minimum. PHP 8 ou
supérieur n'est actuellement pas pris en charge.

1.1 Processus de l'installation

Dans ce document, vous trouverez toutes les informations importantes pour l'installation du
module. Il est important que vous suivez strictement la check-list. Cela garantit une utilisation
du module en sécurité dans le respect des tous les réglements de sécurité.
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La configuration de I'interface d'administration test de Datatrans. Vous pouvez trouver la
plate-forme en cours de test au https://admin.sandbox.datatrans.com/

Configuration des parameétres de base du module de paiement

Configuration des méthodes de paiement

La réalisation d'un achat test par I'intermédiaire du joint test data a la fin de ce document
Sile test a réussi, copiez toutes les données de votre compte test dans le compte live de
Datatrans. L'environnement live peut étre trouvé a URL suivant: https://admin.datatrans.

com

Installation

Par défaut, nos plugins de paiement possédent les parameétres corrects pour la plupart
de nos clients. Cela signifie une fois que vous ayez inséré les informations
d'identification requises dans la configuration du plugin, le plugin devrait étre
entierement opérationnel. Si vous souhaitez recevoir des informations détaillées sur un
parametre que vous ne connaissez pas, vous pouvez contacter notre support.

Si vous avez des problémes pendant l'installation, notre support sera la pour vous. Vous
pouvez nous contacter en cliquant sur le lien suivant: http://www.sellxed.com/support.
Vous avez aussi la possibilité de commander notre service d'installation. Nous
installerons sans problémes le plugin dans votre boutique. http://www.sellxed.com/shop
/de/integration-und-installation.html

Protection de dossier avec votre .htaccess

A fin d'utiliser ce module sans avoir des erreurs, les restrictions d'IP ou de dossiers
doivent étre désactivées. Ceci est nécessaire pour que la notification de paiement de
Datatrans puisse atteindre votre boutique.
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2 Configuration Datatrans - Backend

Pour la configuration, connectez-vous Datatrans dans le Payment Web Administration Tool:

® Environment Test: htt ps://adni n. sandbox. dat at r ans. conl
® Environment Live: htt ps://adni n. dat atrans. conl

Les parameétres mis en place sur les pages suivantes sont une condition préalable pour la
configuration suivante du module principale.

2.1 Configuration - UPP Administration

Sous UPP Administration les parameétres pour le feedback de Datatrans au magasin sont fournis.

La configuration du feedback-URL joue un role central dans la configuration du module. Si les
URL enregistrés ne sont pas correctes, aucun feedback est renvoyé a votre boutique. Le résultat
est que les paiements ne sont pas traités correctement.

URL Successful, URL Failed, URL Cancel sont tous transmis par notre module. Pour cette raison,
entrez aucun dans les cases.

Pour le Transaction Feedback entrez I'URL qui est généré dans le module principal. Plus
d'informations peuvent étre trouvées sous la section Transaction Feedback

Assurez-vous que vous ne cochez pas l'option "Annuler le paiement Lorsque Post-URL n'est pas
disponible" et "Les transactions ont diminuées avec le code de réponse 02".

Atitre d'illustration, nous avons ajouté une capture d'écran:
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Transaktionen Berichte Buchen

UPP Daten Zahlungsarten

UPP Daten

Merchant-ID:
Hénder-Land:
Email:

Sprache:

URL Erfolgreich:
URL Fehler:
URL Abbruch:

URL Post:

URL Post Datenformat:

UPP Designer

UPP Verwaltung Benutzerverwaltung

Sicherheit Fraud Risk Management

1100003396 : Demo Customweb UPP
SWITZERLAND

| info@customweb.ch

sellxed

%= Abmelden

[Z Hilfe

I: Deutsch ::I
|none | Prichtfeld
[none | Phichtreid
[none | Pichtieid
|htlp:Hvourshop.com.ﬂurlfasjnd\caledfinfthefmanual.html | Wahifeld
() Daten in HTML FORM () Daten in XML({request header)
() Daten in XML{request body)
[_] Transaktionen mit Antwortcode 02 ablehnen

[ E-Mail-Benachrichtigungan | |
|| Transaktionen mit Antwortcode 02 ablehnen AMEX

|:I E-Mail-Benachrichtigung an | |
|| Ablehnung, wenn postUrl nicht verfiigbar

Bestdtigen

Image 2.1: Configuration UPP Data.

2.2 Sécurité - Configuration de Sign-Parameters

Le Sign-Parameters sont nécessaires afin de garantir l'authenticité de la communication entre
Datatrans et votre boutique. Ce n'est pas nécessaire de définir le sign parameters, toutefois,
nous vous recommandons fortement d'effectuer les réglages suivants.

Choisissez le HMAC-SHA256 Algorithm pour la signature. En cliquant sur génerer une nouvelle key,
un nouveau sign sera automatiquement créé. Entrez ce sign dans la case correspondante dans
le module principal et notez le dans un fichier texte. Vous en aurez besoin pour la configuration

plus tard.

Nous recommandons également d'utiliser un autre sign2-key. Cliquez sur generer nouvelle key
et notez-le ou copiez-le dans la sign2-box dans le module principal.

En outre, nous recommandons Signer également des demandes de réglement.

Atitre d'illustration, s'il vous plait voir la capture d'écran:
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Sicherheit - Senver-to-Server services security -+ ApplePay key and certificate

Es wird eine zusatzliche Merchant-ldentifikation in den Zahlungsmeldungen mitgeschickt
Der Parameter sign muss immer mit folgendem Wert in jeder Authorisierungs-Meldung mitgeliefert werden

sign = <nones

° Wichtige Parameter werden digital unterschrieben und die Unterschrift (HMAC-SHAZ256) in der Zahlungsmeldung mitgeschickt

Der Parameter sign muss immer in jeder Authorisierungs-Meldung mitgeliefert werden.
Er enthélt eine digitale Unterschrift (ein verschlisselter HashCode HMAC-SHAZ56 in hexadezimal Format).
Unterschrieben werden die Werte der Parameter MerchantlD, Amount, Currency und Reference Nummer (zusammengesetzt)

Ihr HMAC Schlissel (in hexadezimal Format):

84931158e81b65/8eb063fb8e2b155ch03ccd 7773159
2951b473180408101ed39a467176d607dbb1ad8a636b1
Teec479dfbebecdb0c875d587b689333199edd

Einen anderen Schlissel fir sign2 verwenden

acefbe2b30d216e1b34c603e832e4a3d86a82c413358
6a9bbec087c23b9a1626b77a8616e4121b81c29a7eac
9d69e4ff80ca36083efch7bice3ba26b17bcd0b

Die Unterschrift auch bei Settlements verwenden

Image 2.1: Configuration de la sécurité.

- Neuen Schliissel generieren ( Letzte Generierung am 27/06/2017 10:17 )

Der Schilissel muss vor der Anwendung von hex zu byte Format konvertiert
werden.

— Beispiel HMAC-SHAZ256
- Beispiel HMAC-MD5 (weak, not recommended)

-+ Neuen Schlissel generieren (| Letzte Generierung am 27/06/2017 10:17 )

2.3 Sécurité - Activation de la liste blanche des adresses IP

Nous supportons l'option IP whitelisting comme méthode d'authentification a Datatrans. (La
protection serveur a serveur avec mot de passe n'est pas supportée).

Pour le faire, supprimez l'option "Protect server-to-server services with password" et activez
l'option "Enable IP whitelist protection (legacy APIs)".

Ensuite, dans le champ "Adresses IP autorisées”, ajoutez les adresses IP de votre shop/serveur

qui communique avec Datatrans:
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datatrans®

Transaktionen Berichte Buchen UPP Verwaltung Benutzerverwaltung

UPP Daten Zahlungsarten PSD Exemptions UPP Designer Sicherheit Fraud Risk Managemer

Server-to-Server services security < Sicherheit
Protect server-to-server services with password: O U nc h BCP
Username: |
Password: |§
Enable IP whitelist protection (legacy APIs): Check

Permitted IP addresses:
(To separate |IP addresses, please add |IP address per line, emipy
list permits all IPs)

Bestdtigen

& 2023 Datatrans - ver. 3.24 .24

2.4 Gestion des risques de fraude

Sous l'onglet gestion des risques de fraude vous pouvez exclure certains pays d'origine des
cartes de crédit a cause de leur gestion des risques des paiements. Dans ce cas, ces cartes de
crédit seront refusées par le processus d'autorisation de Datatrans.

2.5 Transactions

Dans I'onglet Transactions vous pouvez trouver un apercu des opérations affectées. Vous pouvez
autoriser, débiter ou rembourser directement. Cependant, a cause du gestionnaire de la
transaction intégrée de tous les modules de paiement sellxed, vous pouvez aussi le faire
directement a partir de votre boutique. Attention: Si vous débiter les paiements ici, alors le
statut n' est pas synchronisé avec la boutique. Un prélévement renouvelé dans la boutique
échouera.
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3 Installation du module dans la boutique
OpenCart

3.1 Installation

A ce moment, vous devriez déja étre en possession du module. Si cela ne serait pas le cas, vous
pouvez télécharger les fichiers nécessaires dans votre compte client dans le sellxed shop (Menu
"Mes téléchargements Téléchargements »). Pour télécharger le module dans votre magasin,
suivez les étapes suivantes:

1. Créez le back-up de votre boutique.

2. Extraire le contenu du fichier ZIP que vous avez téléchargé dans votre compte client.

3. Copiez le contenu entier du dossier «fichiers» dans le répertoire principal du serveur de
votre boutique respectivement au dossier dans lequel les plugins sont copiés
normalement. Pour ce faire, utilisez votre programme FTP habituel. Assurez-vous que les
dossiers ne sont pas remplacés, mais simplement fusionnés.

4. Sivous ne l'avez pas encore fait, connectez-vous dans votre boutique.

3.2 Miseajour

Pendant votre période de support, vous pouvez télécharger a tout moment les mises-a-jour du
module. Pour vous abonner aux mises-a-jour veuillez suivre les pas suivants: https://www.
sellxed.com/en/updates_upgrades.

3.2.1 Liste de contréle

N'oubliez pas de suivre les pas suivants avant la mise-a-jour:
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1. Créez un backup avant la mise-a-jour de votre systéme

2. Testez d'abbord la mise-a-jour sur un environnement de test. Nous testons nos modules
dans nos environnements de test, cependant des erreurs peuvent se passer avec d'autres
plugins dans votre boutique.

3. Continuez avec le téléchargement des fichiers sur votre serveur et ouvrez la configuration
principale du module. Sivous utilisez un cache, videz-le.

Quelques mises-a-jour doivent actualiser le schéma de quelques tables la base de donnée. Nous
vous conseillons d'actualiser le module pendant un certain temps ot vous n'avez pas beaucoup
de trafic sur le site.

Attention avec la mise a jour dans votre boutique de production

Si vous avez des problémes pendant la mise-a-jour, notre support sera la pour vous.
Pendant une mise-a-jour il peut y avoir un temps d'interruption, qui peut prendre jusqu'a
plusieures heures dans certains cas.

3.2.2 Instructions pour la mise-a-jour

Avant de faire la mise-a-jour, veuillez lire les étapes a suivre dans le Changelog qui se trouve
dans l'article du module dans notre boutique. Le module actualisera si nécessaire le schéma de
la base de donnée et des fichiers du module. Si rien n'est mentionné, vous pouvez simplement
écraser les fichiers sur le serveur pour completer la mise-a-jour.
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4 Configuration du module dans la boutique
OpenCart

La configuration consiste en deux étapes.La premiére étape correspond a la configuration du
module principal avec tous les réglages de base (cf. Configuration du module principal). Au cours
de la deuxiéme étape, vous pouvez alors effectuer configurations individuelles pour chaque
méthode de paiement . Ceci permet une flexibilité totale et une adaptation parfaite a vos
processus.

Créez des back-ups!

Créez un back-up du répertoire principal de votre boutique. En cas de probléme, vous
sereztoujours en mesure de retourner votre boutique a son état original.

Nous recommandons en outre de tester l'intégration sur un systéme de test. Des
complications peuvent survenir avec des modules tiers installés par vous. En cas de
questions, notre équipe de support est a votre entiére disposition.
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5 OpencCart 3.0 Installation - Additions

Afin de garantir le bon fonctionnement et utilisation de toutes les fonctionnalités assurez-vous
que vous suivez les instructions ci-dessous.

5.1 Configuration du module principal

Vous trouverez les parameétres pour le module principal dans "Extension > Modules > Datatrans
Base Module" . Installez le module en cliquant Installer.

En cliguant Modifier vous pouvez configurer le module principal. Insérez toutes les données dans
les champs correspondants. Les données nécessaires ont déja été enregistrées dans le back-
end de Datatrans a été envoyé par Datatrans. Chaque option est, en outre, expliquée dans des
courts textes d' informations dans la boutique.

5.2 >Definir 'URL pour le Feedback Transaction

Pour assurer un traitement de paiement correct dans votre boutique, au moins un Feedback URL
doit étre fourni pendant la configuration de Datatrans . L'URL a saisir peut étre trouvé dans votre
boutique OpenCart dans le menu Extensions > Modifications > Modules > Datatrans Base Module
> Edit > More > Setup.

5.3 Configuration du module de paiement

Aprés avoir réussi a configurer le module principal, vous pouvez trouver les parameétres pour les
méthode de paiement individuelles dans votre boutique dans Extensions > Paiements . Chaque
méthode de paiement est listée individuellement. Installez les méthodes de paiement que vous
souhaitez offrir @ vos clients dans votre boutique. Vous pouvez effectuer des réglages individuels
pour chaque méthode de paiement et ainsi adapter de facon optimale les méthodes de
paiement a vos processus existants. Les options les plus centrales sont décrites plus en détail ci-
dessous..

En cliquant sur Installer la méthode de paiement est activée dans votre boutique. Cliquez
Modifier afin de modifier la configuration de la méthode de paiement.
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5.4 Débit direct

L'option "Capture" vous permet de spécifier si vous voulez débiter les paiements directement ou
sivous souhaitez les authorisé et le débit du paiement a une date postérieure.

En fonction de votre contrat d'acquisition, une réservation est garantie seulement pour une
période de temps spécifique. Si vous échouez a débiter le paiement dans ce délai, l'autorisation
peut donc plus étre garantie. De plus amples informations sur ce processus se trouve ci-dessous.

Différents parametres entre le backend de Datatrans et le module

Les parameétres enregistrés dans les modules de paiement peuvent remplacer les
parameétres enregistrés dansDatatrans.

5.5 Statutincertain

Vous pouvez spécifiquement étiqueter les commandes pour lesquelles la réception de I'argent
n'est pas garantie. Cela vous permet de contréler manuellement la commande avant I'expédition.

5.5.1 Définition du statut de la commande

Pour chaque mode de paiement, vous pouvez spécifier le statut vers lequel la commande doit
étre déplacée en fonction du statut de la réservation. C'est le statut initial de la commande.

5.6 Validation

Avec l'option «Validation», vous pouvez définir le moment ol le mode de paiement doit étre
rendu visible pour le client au cours du processus de commande. Ce parameétre est pertinent
pour les modules ol l'utilisation dépend de la conformité du client avec des conditions
préalables spécifiques. Par exemple, si un contrdle de solvabilité doit etre effectué ou si le mode
de paiement est disponible uniquement dans certains pays. Pour que la vérification de la
solvabilité ou la validation de I'adresse fonctionne également avec les caractéres européens, le
jeu de caractéres du "mode Blowfish" doit étre réglé sur "UTF-8" pour certains parametres PSP.

Vous avez le choix entre deux options:

* Validation avant la sélection de la méthode de paiement: Une vérification de validation est
effectuée avant que le client sélectionne la méthode de paiement. S'il ou elle ne satisfait
pas les conditions, la méthode de paiement ne sont pas affichées

¢ Validation aprés la sélection de la méthode de paiement: La vérification de la conformité a
lieu aprés la sélection de la méthode de paiement et avant la confirmation de la
commande

e Au cours de l'autorisation: La vérification de validation est effectuée par Datatrans au
cours de la procédure d'autorisation. Le mode de paiement est affiché dans tous les cas
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6 Réglages / Configuration des Méthodes de
paiement

6.1 Informations générales sur les méthodes de paiement

Tous les modules de paiement sellxed sont livrés avec des méthodes de paiement les plus
courants. In case a desired payment method is not included per default, please contact us
directly.

Afin d'étre en mesure d'utiliser un méthode de paiement, il doit étre activé dans votre compte
Datatrans ainsi que dans votre boutique. Les informations sur la configuration des méthodes de
paiement peuvent étre trouvé plus haut.

Ci-dessous vous trouverez des informations importantes pour les méthodes de paiement
spécifiques qui dérogent a la procédure standard.

6.2 Informations sur le statut du paiement

Pour chague méthode de paiement, vous pouvez définir les statuts a saisir aprés compléter une
transaction (statut pour les paiements autorisés, capturés etc.). Vous pouvez définir le statut de
la commande pour chaque statut de transaction different (par exemple: un statut pour un
capturé, autorisé, etc.).

Information importante concernant le statut de la commande

Ne définissez jamais un de vos status sur Pending Datatrans ou tout autre statut
similaire qui vient directement du module.

6.2.1 Statut de la commande "pending" / paiement imminent (ou similaire)

Les commandes avec le statut 'Pending Datatrans' sont des commandes qui n'ont pas été
terminées. Les commandes recoivent ce statut si un client est redirigé a la page de paiement,
mais n'a pas réussi a finir la son paiement ou la notification du paiement n'a pas encore atteint
votre boutique (Par exemple le client ferme la page de paiement et ne compléte pas le
paiement). Selon la méthode de paiement, ces commandes seront automatiquement
transformées en commandes annulées et l'inventaire sera corrigé (un cronjob doit étre activé).
La durée de ce changement automatique dépend des caractéristiques de la méthode de
paiement. Cela ne peut pas étre configureé.

Si vous avez beaucoup de commandes sans avoir été finalisées, cela signifie généralement que
les notifications de votre serveur Web a Datatrans sont bloquées. Dans ce cas, veuillez vérifier
les paramétres de votre firewall et demandez a votre hébergeur d'accepter les IP et les User
Agent de Datatrans.
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6.2.2 Statut de commande "annulé"

Les commandes avec le statut "annulé" ont recu ce statut automatiquement a cause d'un délai
d'expiration, comme décrit ci-dessus, ou ont été annulées directement par le client.

6.3 Openinvoice / Facture via MFGroup ou Swissbilling

Avec votre module Datatrans vous avez désormais la possibilité de traiter les factures via
MFGroup (POWERPAY) ou Swissbilling. Pour le faire, activez comme d'habitude la méthode de
paiement dans votre magasin et sélectionnez le processeur dans la liste déroulante.

En outre, vous avez la possibilité de choisir, s'il devrait y avoir une vérification de crédit dans le
background avant que la méthode de paiement soient montrée. Et si la méthode de paiement
doit étre caché au cours d'un feedback négatif. Pour étre en mesure de le faire, les options
appropriées doivent étre activés par Datatrans et le processeur. Définissez en " validation " le
bon moment dans le temps. Vous avez trois options:

1. Avant la sélection de la méthode de paiement: Cette option vous permet de traiter Ia
vérification de crédit avant l'affichage de la méthode de paiement

2. Aprés la sélection de la méthode de paiement: La vérification de crédit est traitée apres
que le client a choisi une méthode de paiement, mais n'a pas terminé la comande.

3. Au cours de l'autorisation: Ceci est standard. Le traitement se déroule pendant
l'autorisation par votre Datatrans.
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7 Le module en action

Ci-dessous vous trouverez un apercu des caractéristiques les plus importantes dans l'utilisation
quotidienne du module Datatrans.

7.1 Données de transaction des commandes

Vous pouvez trouver un résumé des données de transactions les plus importantes pour toutes
les commandes passées via notre module. L'ensemble des données de transaction permettent
['attribution des commandes avec les transactions correspondantes sur votre compte Datatrans.

[E] orders

Order Detalls Grder D 2

Invoice No [ Generate ]

Payment Details

Shipping Detalls Store Name Your Store

: D: X £ .
Products Store Url. hitp:lidemo.sellxed.com

Customer. Sascha krisi

History

Customer Group: Default

E-Mail: info@customweb.ch

Telephone 33123456798

Total: 78.90€

Order Status: Pending

IP Address: 1608515547

User Agent Mozilla/5.0 (X11; Linux x86_64) AppleWebKit/537 36 (KHTML, like Gecko) Ubuntu Chromium/30.0.1589.114 Chrome/30.0.1598.114 Safari/537 36
Accept Language: de,en-US;g=0.8.en,q=0.6

Date Added. 13/11/2013

Date Modified: 13M11/2013

Image 7.1: Données de transaction sur OpencCart.

7.2 Utilisation Alias Managers / Token Solution

Avec |' Alias Manager, vos clients peuvent en toute sécurité sauvegarder leurs cartes de crédit
avec Datatrans pour les achats ultérieurs. L'utilisation est activé en sélectionnant l'option "Alias
Manager" dans la configuration de Payment. Le client peut alors choisir parmi ses cartes de
crédit enregistrées sans avoir a entrer de nouveau tous les détails.
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Use Stored Card | ooooooooox 0111 7

Card Holder Name*  Sascha krusi

Please enter here the card holder name on the card.

Card Number* 0000 0000 00 0111
Please enter here the number on your card.

Card Expiration® 12 Y 2015 ¥

Select the date on which your card expires.

CVC Code*

Please enter here the CVC code from your card. You find the code on the back of the card.

Confirm Order

Image 7.1: Alias Manager

Alias Manager Options

L'utilisation de I' Alias Managers nécessite l'activation de I'option correct avec Datatrans.
Pour le mettre en place contactez notre support.

7.3 Débit / annulation de commandes

7.3.1 Capturer les commandes

Afin de capturer les commandes, ouvrir les informations de transaction dans Sales > Datatrans .
Vous trouverez ici un apercu de toutes les transactions.Vous y trouverez des informations sur la
transaction. En cliquant sur "vue" vous ouvrirez la transaction de l'ordre.

7.3.1.1 Capture commandes complétes ou la capture partielle

En cliqguant sur le bouton "Capture Transaction" une nouvelle fenétre s'ouvre. Vous pouvez
maintenant capturer chaque élément individuellement au cas ot vous ne souhaitez pas envoyer
tous les éléments a la fois. La quantité de possibles captures partielles dépend de votre contrat.
Contactez Datatrans directement pour clarifier vos questions.

Capture des commandes dans le back-end de Datatrans

La gestion des transactions entre votre boutique et Datatrans n'est pas synchronisée. Si
vous capturez des paiements avec Datatrans, le statut dans la boutique ne sera pas mis
ajour et une seconde capture dans la boutique n' est pas possible.

Au cas ol vous ne souhaitez pas capturer tous les éléments d'une commande, vous pouvez
fermer la transaction en cliquant sur la boite.
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With the following form you can perform a partial capture.

Name SKU Type Tax Rate
iPhone product 11 product 0%
Flat Shipping Rate shipping shipping 0%

Image 7.1: Capture des commandes

Capture Partiel

Quantity Total Amount (excl. Tax) Total Amount (incl. Tax)
1 | 74.24 | 74.24
1 | 3.68 | 3.68

Total Capture Amount: 77.91 EUR

Close transaction for further captures

Capture

Vérifiez si la capture de quantités partielles est pris en charge avec votre contrat avec
Datatrans . Si cela est le cas, que la transaction soit fermée pour de nouvelles opérations

aprés une capture partielle.

7.3.2 Annuler les commandes

En cliquant "Annuler la Transaction”, la transaction est annulé et le montant de la réserve sur la

carte de votre client est automatiquement rendu.

Capture Transaction

Image 7.1: Capturer ou Annuler in OpencCart.

7.4 Remboursement des commandes

Refund Transaction

Afin de rembourser les commandes, ouvrir les informations de transaction (cf. above).

Vous pouvez rembourser des éléments individuels ou tout montant de votre choix en modifiant

la quantité totale ou la quantité d'articles.
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PARTIAL REFUND

With the following form you can perform a partial refund.

MName SKU Type Tax Rate Quantity Total Amount (exel. Tax) Total Amount (incl. Tax)

iPhone product11  product 0% | 1 | 74.24 [ 7424

Flat Shipping Rate shipping shipping 0% I 1 I 3.68 I 368
Total Refund Amount: 7791 EUR

Close transaction for further refunds

Image 7.1: Remboursement OpenCart pour Datatrans.

Remboursement maximal

Avec notre module il est impossible de rembourser plus de 100% du montant autorisé
initialement.

7.5 Mise en place d'un cron job pour activer les opérations
chronomeétrées

Pour activer les opérations chronométrées du plugin (e.g. update service, deleting pending
orders, etc.) assurez vous que vous avez activé le Cron Engine de OpenCart . En particulier, la
fonction de mise a jour vous permet de récupérer automatiquement des informations
supplémentaires ou change votre commande directement via I'API deDatatrans. Pour utiliser la
fonction mise a jour, peut etre que Datatrans doit activer des options supplémentaires dans
votre compte.

Pour utiliser les opérations chronomeétrées, planifiez un cron job dans votre server pour le
controller suivant:

https://www.your-shop.com/index.php?route=datatranscw/cron/cron

0On vous conseille d'utiliser un Cron Engine come par example EasyCron. De cette fagon, vous
pouvez Cela vous permet d'ouvrir le fichier (URL) avec un service externe.
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8 Testing
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Avant de passer au mode productif, vous devez tester le module.

Apreés vos tests

N'oubliez pas de changer au mode productif aprés avoir fini vos tests.

8.1 Données de test

Voici les donnés de test:
Credit / Debit Card

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Kartennummer
Expiry Date
cvc

Visa
Kartennummer
Expiry Date
Ccvc

MasterCard
Kartennummer
Expiry Date

49500 0000 0000 0003
12/2021
123

5200 0000 0000 0007
12/2021
123

5200 0000 0000 0080
12/2021
123

375000000000007
12/2021
1234

3616 7719 110 012
12/2021
123

35699900 1003 0400
12/2021
123

6759 6498 2643 8453
12/2021
123

49500 0000 0000 0003
12/2021
123

5200 0000 0000 0007
12/2021

Visa: With 3-D Secure Check

MasterCard: Without 3D-Secure

MasterCard: With 3D-Secure

American Express: With 3D Secure

Diners

JCB

Maestro UK

Visa: With 3-D Secure Check

MasterCard: Without 3D-Secure
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Kartennummer
Expiry Date
cvc

American Express

Kartennummer
Expiry Date
Ccvc

Diners Club
Kartennummer
Expiry Date
cvc

JCB
Kartennummer
Expiry Date
cvc

Maestro UK
Kartennummer
Expiry Date
cvc

123

5200 0000 0000 0080
12/2021
123

375000000000007
12/2021
1234

3616 7719 110 012
12/2021
123

35699900 1003 0400
12/2021
123

6759 6498 2643 8453
12/2021
123

sellxed

MasterCard: With 3D-Secure

American Express: With 3D Secure

Diners

JCB

Maestro UK
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9 Erreurs et solutions

Vous trouverez notre FAQ avec les erreurs et leurs solutions sous http://www.Ssellxed.com/en/faq
. Si le probléme n'est pas résolu, vous pouvez contacter notre support sous: http://www.sellxed.
com/en/support

9.1 L'URL'Referrer' apparait dans Analytics

Dans certains cas, les URL's 'Referrer' sont falisifée par Datatrans dans Analytics. Cela se passe
quand le client envoie une 'Header Redirection'. Cela peut étre résolu dans la configuration de
votre systéme Analytics.

Pour Google Analytics, un example pour PayPal ce trouve ici.
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